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CHAPTER A INTRODUCTION 

A.1.    Short description of GLASTA 

The method of Glaser is commonly used to simulate vapour diffusion and condensation in walls.  
Although the method is easy to understand, a serious effort is required if the method has to be 
applied using a pocket calculator and manual drawing instruments.  Therefore, the use of a 
computer to apply the method is obvious.  A second fact, which was preceding the development 

of the computer program, GLASTA, is that our present-day knowledge about building physics 

allows a better simulation of the humidification and drying process in materials compared to the 
Glaser method.  The application of the definition of the critical water content was used to develop 
an extended method.  A clear visualization of the humidification and drying process is one of the 
important merits of this extended method.  Of course the hygrothermal behaviour of materials is 
a complex subject, and several assumptions were still necessary. 

A.2. Technical specifications 

- GLASTA is a 32-bit Windows program. GLASTA is installed in C:\Program Files 

(x86)\Physibel\BISTRA. 
In this folder the executable file is GLASTA.exe. 

- GLASTA is protected by either a hardware key, provided by Physibel, or a software licence 
(A.4). 
The demo version of GLASTA is not protected (but allows only manipulation of selected 

prepared demo-files). 
 

The Physibel 32-bit programs need several shared libraries (.dll files) from Microsoft. 

The Microsoft Visual C++ 2017 Redistributable Package (x86) is included in the installation files of 
GLASTA, but can also be downloaded from https://support.microsoft.com/en-
us/help/2977003/the-latest-supported-visual-c-downloads. 

A.3.  License statement 

Copyright law and international treaties protect this computer program. Unauthorized 
reproduction or distribution of this program, or any portion of it, may result in severe civil and 

criminal penalties, and will be prosecuted to the maximum extent possible under the law. 
 
IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL LICENSOR, 

OR ANY OTHER PARTY WHO MAY REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE 

TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL 

DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT 

LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY 

YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER 

PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF 

SUCH DAMAGES. 

https://support.microsoft.com/en-us/help/2977003/the-latest-supported-visual-c-downloads
https://support.microsoft.com/en-us/help/2977003/the-latest-supported-visual-c-downloads
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A.4. Licence 

The Physibel applications are protected by a licence, to prevent illegal use of the software. This 
can be either a hardware licence (Sentinel USB key) or a software licence. 

A.4.1. Hardware licence 

Perpetual licences are protected by a hardware licence (Sentinel USB key). The licence is locked 
to this dongle. It is strongly recommended to take a financial assurance for loss of the key by theft 
or any other incidence. 
 
Before GLASTA can be used, the driver (delivered with purchase) for the hardware key needs to 
be installed. Administrator rights are needed for this installation. It might be necessary to restart 
your computer after installing the driver. 
 
During use of GLASTA, the dongle needs to be attached to the computer at all times. 

A.4.2. Software licence 

Subscription licences are protected by a software licence. After first installation of GLASTA, the 
user needs to activate the licence using the activation code received upon purchase of the 
software. When first opening GLASTA, the Software Licence Manager will open automatically 

and prompt the user to activate the licence, or to register in the network floating database, 
depending on the licence type. The computer needs to be connected to the internet for this 
licence activation. Cloud-based floating licences need to be activated every time when opening 
the application. 
 
After activation, the Software Licence Manager is available from the menu for stand-alone 
licences: 
Help → Software Licence Manager… 
 
This allows the user to check the expiry date of the licence subscription and be redirected to 

renew the licence. 

 
Users with a floating network licence can check out a licence from the database for a maximum 
period of 3 days. 
Help → Check out/in floating licence… 
 
The software licence key for GLASTA is linked to the computer where it was activated. When you 

want to move the application with a stand-alone licence to another computer, you can 
deactivate the licence in the Software Licence Manager. The licence can then be reactivated on 

a new computer. 
 
If the Software Licence Manager is unavailable from the application itself, you can also open it 

from the command prompt. You need to first change directory to the Program Files folder where 
the application is installed. Then, open the Software Licence Manager with the following 
command: 
QlmLicenseWizard.exe /settings “GLASTA 5.1.lw.xml” 
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A.5. User Account Control (UAC) 

Administrator rights are necessary to install GLASTA on a computer. 
 
The installation of the application is machine-level, meaning all user accounts can access the 
application after installation. 

 
In case of a software licence, the licence for GLASTA is linked to the computer, but is stored at the 
user level. Each user account on a computer has to activate the licence in order to have access to 
the licence. 

A.6. Overview of delivered files and file structure 

GLASTA is installed (when the user has accepted the default destination) in the folder 
C:\Program Files (x86)\Physibel. 

 
The following files are installed 
Folder File Description 
…\Physibel\GLASTA5 GLASTA5.exe GLASTA (32-bit) program 

 *.dll, *.pat Program resources 

 QlmLicenseWizard Software Licence Manager files 
…\Physibel\Materials *.phm Material databases 

…\Physibel\Manuals GLASTA5Manual.pdf GLASTA manual 
 GLA***.pdf GLASTA How to’s 
 

By default, project files are saved in the user’s Personal Folder (Documents). The following folders 
are created: 
 

…\Physibel\GLASTA5\PROJECTS Project data 
*.GLP files 

…\ Physibel \GLASTA5\CLIMATES Climate data 

*.BOC climate data files 
*.BOD partial climate data files 

…\ Physibel \GLASTA5\WALLS Wall data 
*.WAL files 

…\ Physibel \GLASTA5\REPORTS Output directory for reports and report scripts 
*.REP report definition scripts 

*.DOC files 
 
The parameter file GLASTA.prm (see A.7) is installed in C:/ProgramData/Physibel/GLASTA5 

(machine-level), and copied to each user account’s application data folder when first opening 
GLASTA (C:/Users/username/AppData/Roaming/Physibel/GLASTA5). 

A.7. Program parameters 

The global default values (see B.2) are saved in the file GLASTA.prm in the application data folder 
(C:/Users/username/Appdata/Roaming/ Physibel/GLASTA5).  When the program GLASTA is 
started, the program parameters are loaded from the parameter file. 
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CHAPTER B  GETTING STARTED 

B.1. Choosing a language 

The ‘Language’ submenu allows changing the language.  The chosen language becomes 
effective the next time the program is started. 

B.2. Changing program settings 

4 groups of program settings can be edited in the ‘Settings’ submenu under the ‘General’ 
keyword: 

− 2 calculation parameters (saved in each project file) can be edited: 
The maximum allowed movement of moisture front per calculation step. 
In the Glaser++ method, the calculation step is automatically decreased if the waterfront 
moves more than the quantity specified. 
The inverse of the water vapour permeability of air [m s Pa/kg] is a quantity used in the 
Glaser formulas (cf. Chapter E, Calculation Principles).  The value depends slightly on the 
temperature and on the atmospheric pressure and effects the vapour flow amounts. 

Typical values are: 
- N = 5.4e+009 m s Pa/kg (used in the previous GLASTA versions) 

- N = 5.0e+009 m s Pa/kg (according to prEN ISO 13788 [ref. 7]). 
− The water content limits in the Water content diagram (Figure 1) are related to the judgment 

of the condensation amount.  Yearly resulting condensation is normally considered as 

unacceptable, but if the condensation is not resulting, i.e. it yearly dries out, the acceptability 
depends on the material type.  According to [ref. 1, 1’] e.g. a condensation amount higher than 
the limits as listed in Figure 1 are unacceptable.  The user can specify other values, e.g. 

according to national requirements. 
 

 

Figure 1:  Water content limits 

− The moisture patterns, i.e. the colour patterns used in the graphs. 
− The font size. 
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CHAPTER C  USING GLASTA 

C.1. The project file 

A project file contains all links to the input elements related to one calculation: 
− a project title, 
− a climate, i.e. the successive boundary conditions at both wall sides, 
− a wall, i.e. a multi-layered construction, 

− a calculation method. 

 
Opening the program a new project is started. 
Existing project files can be opened using the ‘File’ menu (Figure 2). 
Only one project can be opened at the same time. 

 

Figure 2:  The File menu 

A project can be saved by using the ‘Save’ or the ‘Save As’ menu item. 
 
The left side of the screen (Figure 3) displays the project input elements and allows to edit them. 

With the  button the Climate or the Wall selection dialog is opened. 

 

Figure 3:  The Project Bar 
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C.2. Selecting and editing the Climate data 

Climate data (corresponding to .BOC files) can be selected from the menu bar or from the 
project bar.  The available climates are graphically previewed during the selection (Figure 4).  
The climate editor window (Figure 5) is opened from the menu bar or by double-clicking the right 
margin of the climate sheet. 

 

Figure 4:  The Climate Selection dialog 

 

Figure 5:  The Climate Editor 

Climate data consist of successive periods (a cycle) for which temperature and air humidity at 

both sides of the wall are specified. 
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For each period the following data have to be specified: 

− Name the name of the period, 
− Duration [Days] the duration of the period in days, 
− n [°C] the temperature at side n, 
− n [%] the relative humidity at side n, 

− pn [Pa] the vapour pressure at side n, 
− Number of cycles the number of cycles to be considered in the calculation. 

 
Editing functions to add, copy, move and delete climate periods are available under the ‘Edit 
Period’ submenu or on the ‘Toolbar’. 
Using the ‘Load climate side n’ button, the climate at one side can be loaded from a database of 

climates (corresponding to .BOD files) into the climate (.BOC file) being edited.  Monthly average 
data for more than 100 stations are available.  Also 4 inside climate classes according to [ref. 1,1’] 
are available.  The leading characters of inside climate file names is ‘IC_’. 

The climate can be saved from the ‘File’ menu. 
The climate can be selected into the current GLASTA project by using the ‘Select’ button. 
 
Using the ‘File Converter’ in the ‘File’ menu, climate data (*.BOC and *.BOD files) created in 
former GLASTA versions can be converted to the latest GLASTA version. 
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C.3.  Selecting and editing the Wall data 

Existing wall data (corresponding to .WAL files) can be selected from the menu bar or from the 
project bar.  The available walls are graphically previewed during the selection  (Figure 6).  
The wall editor window (Figure 7) is opened from the menu bar or by double-clicking the wall 
sheet. 

To create new wall data the ‘File’ menu or the ‘New’ function on the ‘Toolbar’ can be used. 
 
Using the ‘File Converter’ in the ‘File’ menu the wall data (.WAL files) created in former GLASTA 
versions can be converted to the latest GLASTA version. 

 

Figure 6:  The Wall selection dialog 

 

Figure 7:  The Wall editor 
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The wall data describe the successive wall layers, the 2 wall boundaries, the general wall 

quantities and the style used in the graphical representation of the wall. 
 
Wall layers 
For each wall layer the following data have to be specified: 

− Name layer name, 
− d [m] the layer thickness, 
−  [W/mK] the material thermal conductivity, 
− R [m2K/W] the layer thermal resistance, 
− µ [-] the material vapour resistance factor, 
− µd [m] the layer equivalent diffusion thickness 

− hup [-] a flag indicating whether or not the material can be humidified by interstitial 
condensation.  This property (and therefore also the following three material 
properties) is only relevant if the extended Glaser method (Glaser++) is used, 

− wcr [kg/m3] the material critical water content (only relevant in case of hup = 1), 
− wmax [kg/m3] the material maximal water content (only relevant in case of hup = 1); its value 

has to be equal or higher than wcr, 
− w [kg/m3] the material initial water content (only relvant in case of hup = 1); its value has to 

be equal or higher than wcr or zero, 
− pattern the material pattern used in the wall graphs.  It is selected from a table (Figure 

8) using ENTER or double-click. 

 

Figure 8:  The material patterns 

Material properties can be loaded from a material database from the ‘Edit Layer’ submenu 

‘Load Material’ item or using the M-button (Figure 10, button 10). 

The structure of the material database is clarified in Figure 9.  The database consists of several 
sub-databases (.PHM files).  Each sub-database consists of several material groups.  Each 
material group consists of several materials. 
The sub-databases distributed with the software correspond to national standards and scientific 
reports.  The material were grouped according to the material type (metals, concrete, masonry, 
insulation,…). 
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Figure 9:  The Material database structure  

Editing functions to add, copy, move and delete layers are available under the ‘Edit Layer 
submenu or on the ‘Toolbar’ (Figure 10). 

 

Figure 10:  The Toolbar 

1: New / 2: Open / 3: Save (wall data) 
4: Copy / 5: Move / 6: Stop Move / 7: Delete / 8: Add before / 9: Add after (layer) 

10: Load material from database 

Wall boundaries 
For both wall boundaries the following data have to be specified: 
− Name boundary side name, 
− hn [W/m2K] the surface heat transfer coefficient on side n; for new walls a default value of 

25 W/m2K is assumed at side 1 and of 7.7 W/m2K at side 2,  

− µdn [m] the surface equivalent diffusion thickness on side n; for new walls a default value 

of 0.0014 m is assumed at side 1 and of 0.0084 m at side 2. 

It is recommended to take side 1 as the outside environment and side 2 as the inside environment 

to make profit of the default values. 
 
General wall quantaties 
The following wall quantities, derived from the data, are displayed in the Wall editor: 
− d [m] the wall thickness,  

− U [W/m2K] the wall heat transfer coefficient,  
− Rc [m2K/W] the wall thermal resistance (R),  

− µd [m] the wall equivalent diffusion thickness (µd). 
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Style 

The style used in graphical wall representations is defined by: 
− the orientation Wall sections can be represented horizontally or vertically.  The orientation is 

used in all wall graphs (Glaser diagram, moisture distribution diagram, …). 
− the scale A scale value higher than the wall thickness defines the length of the distance 

axis used in the wall graph.  Scaling is interesting to represent different walls 
using the same scale.  By using Auto scaling, the largest representation possible 
is used. 

 
The wall can be saved from the ‘File’ menu. 
The wall can be selected into the current GLASTA project by using the ‘Select’ button. 

C.4. Calculation method 

The calculation method (Glaser, Glaser++ or Glaser DIN) can be selected from the project bar or 
from the menu bar. 
Chapter F describes the calculation methods in detail. 
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CHAPTER D PROJECT SHEETS 

Having selected or edited a project, the Glaser calculation is automatically done and the results 
are immediately displayed on the 8 project sheets. 
Each page is accessible by clicking its labeled tab below the page or from the ‘View’ menu. 
Each page can be printed from the ‘File’ menu ‘Print’ item. 
Each graphic page can be saved as a figure in PNG format (cf. Chapter E). 

D.1. Page 1: The Climate 

 

Figure 11:  The Climate 

The climate page (Figure 11) is a graphic representation of the climate data. 
Double-clicking on the right margin opens the climate editor. 



 

Manual GLASTA v5.1 17 

D.2. Page 2: The Wall 

 

Figure 12:  The Wall 

The wall page (Figure 12) is a graphic representation of the wall data. 
It also shows the proportional distributions of the thermal resistance and of the diffusion 

resistance. 
Double-clicking on the wall sheet opens the wall editor. 

D.3. Page 3: The Moisture distribution evolution 

The moisture distribution evolution represents the moisture distribution in the wall as a function of 

time. 
 
In case of the Glaser++ method (Figure 13) humid zones of layers are coloured.  3 different 
patterns may be used, respectively to indicate critical water content, above critical water content 
and maximal water content.  The patterns for the humid zones are editable program parameters 
(cf. chapter B). 
 

In case of the normal (Figure 14) or the DIN-Glaser method the water content in the interfaces is 
represented by a small block.  Two different patterns are used: one for condensation and one for 
drying. 

 
Double-clicking the diagram allows changing the time scope of the diagram.  The time scope 
defined is used on all project sheets using a scope. 
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Figure 13:  The Moisture distribution evolution (Glaser++) 

 

Figure 14:  The Moisture distribution evolution (Glaser normal) 
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D.4.  Page 4: The Water content evolution diagram 

 

Figure 15:  The Water content evolution diagram 

The water content evolution diagram represents the total quantity of water [kg/m2] present in the 
wall as a function of time.  A logarithmic scale is used for the vertical axis. 

 
The horizontal dotted lines with labels A, B, C … correspond to the limits defined in the program 
parameter settings (cf. chapter B). 
In Figure 15 three limits (A: 0.05 kg/m2, B: 0.15 kg/m2, C: 0.50 kg/m2) are used.  These limits were 

deduced from [ref. 1, 1’].  This reference states that condensation is allowed: 
− if there is no calculated accumulation of condensation from one year to the next, 
− if the yearly maximum quantity of condensation is lower than: 
 A 0.05 kg/m2 for vegetable material with not waterproof glues. 

 B 0.03 d [kg/m2] for vegetable material with waterproof glues.  The limit B was 
obtained by assuming a default density  = 500 kg/m3 and a default 

thickness d = 0.01 m. 

 C 0.05 wcrd [kg/m2] for stony frost sensitive materials.  The limit C was obtained by 
assuming a default critical water content wcr = 100 kg/m3 and a 

default thickness d = 0.1 m. 

Building regulation in other countries may prescribe other limits, which can be defined in the 

program parameters. 
 
If the DIN Glaser method is used, the water content diagram is not relevant.  The method 
assumes that the condensation interface remains wet all the time (to allow more drying than 

wetting) and therefore the total water content is an artificial quantity. 
 

Double-clicking the diagram allows changing the time scope of the diagram.  The time scope 
defined is used on all project sheets using a scope. 
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D.5.  Page 5: The Glaser tables 

 

Figure 16:  The Glaser tables 

The Glaser tables (Figure 16) contain the alphanumeric results of the Glaser calculation at each 
time step (cycle / period / offset).  The same time scope is used as in the water distribution 

diagram and the water content diagram. 
 
For each material layer it contains: 
− the layer name, 

− the thickness d [m], 
− the mass transfer during the period considered Qm[kg/m2], 
− the water content at the start W-offset in [kg/m2], 
− the water content at the start w-offset in [kg/m3]. 

Dry and wet parts are considered as separate layers. 
 
For each interface it contains: 

− the temperature  [°C], 
− the saturation vapour pressure ps [Pa], 

− the vapour pressure p [Pa], 
− the amount of condensation (>0) or drying (<0) cond [kg/m2]. 
 
For the total wall it contains: 
− the thickness d [m], 
− the amount of condensation (>0) or drying (<0) cond [kg/m2], 
− the water content at the start W-offset in [kg/m2]. 
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D.6. Page 6: The Glaser diagrams 

 

Figure 17:  The Glaser diagrams 

The Glaser diagram (Figure 17) is the graphical representation of the vapour pressure (blue solid 
line) and of the saturation vapour pressure (red dotted line) in the wall.  In the interfaces where 

there is a contact between both courses, condensation or drying occurs.  Coloured arrows 
emphasize these interfaces.  The saturation vapour pressure line can be read also as the 
temperature course through the wall, using the non-linear temperature scale at the bottom (or at 

the right if the wall is represented vertically).  Possible waterfronts are represented by dotted 

lines.  In humid layers, the vapour pressure and the saturation vapour pressure coincide. 

 
The arrow buttons right below allow to display the diagrams for previous and next periods. 
 

An animation of successive Glaser diagrams can be generated (cf. Chapter E). 
 
Double clicking on the Glaser diagram shows a dialog box, which allows switching to a linear 

temperature scale. 
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D.7. Page 7: The Condensation table 

 

Figure 18:  The Condensation table 

The condensation table (Figure 18) contains for each calculated period of the defined scope the 
following: 

− cycle number [-], 
− period number [-], 
− offset [days], 

− duration [days], 

− condensation quantity [kg/m2], negative if drying occurs, 

− total layer water content at the start W-offset [kg/m2], 
− total interface water content at the start Wi-offset [kg/m2]. 
 

The same time scope is used as in the water distribution diagram and the water content 
diagram. 
 

Using the normal Glaser or the Glaser DIN methods, W-offset is always being zero. 
Using the Glaser++ method, both W-offset and Wi-offset can be different from zero, depending 

on whether the condensation is absorbed by the materials or condensation occurs between two 
layers with hup = 0. 
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D.8. Page 8: The GLASTA summary 

 

Figure 19:  GLASTA summary 

The summary (Figure 19) contains the following information: 
- the time scope (from ... until) considered and its duration,  

- the calculation method used, 
- the total amount of condensation [kg/m2], 
- the total amount of drying [kg/m2], 

- the ratio drying amount versus condensation amount [-], 

- the vapour flows entering and leaving the wall at both sides, and their total (entering minus 

leaving) [kg/m2], 
- for each layer: 
 - the layer name,  

 - the maximum water content found wmax in [kg/m3], 
 - the maximum thickness of the humid zone found dmax [m], 
 - the maximum water content found Wmax in [kg/m2], 

 - the percentage of the time that the layer is humid, 
- for the total wall: 

 - the maximum water content found Wmax in [kg/m2], 
 - the percentage of the time that water is present in the wall. 
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CHAPTER E REPORTING FEATURES 

E.1.  Saving graphic pages 

Each graphic page can be saved as a figure in PNG (© Portable Network Graphics Group) 
through the ‘Report’ submenu or using the disk buttons on the ‘Toolbar’.  
 

 

Figure 20:  Bitmap export module 

The input parameters for a figure are (Figure 20): 

− horizontal and vertical pixel size, 
− output file name (*.bmp, *.png). 
The bitmap file is created in the Reports directory.  

E.2. Making a report in MS Word 

The Physibel report generator module can make a full report of the calculation results in MS 

Word format.  The different items included in the report have to be defined in a report script.  The 
script can be edited in the Report editor (Figure 21) which can be started from the ‘Report’ 
submenu or using the W-button on the ‘Toolbar’. 
 
The report script includes the following items: 
- a report file name (.doc file),  

- a list of output items.  The following items can be choosen (by double clicking): 
 - Title, 

 - Input summary, 
 - Climate data as text, or as figure, 
 - Wall data as text, or as figure, 

 - Moisture distribution evolution diagram, 
 - Water content evolution diagram, 
 - Glaser tables, 
 - Glaser diagrams, 

 - Condensation table, 
 - GLASTA summary report. 
- for the last 6 items the time scope: begin cycle (BC) and begin period (BP), end cycle (EC) and 

end period (EP). 



 

Manual GLASTA v5.1 25 

 

Figure 21:  The report script editor 

Editing functions to add, copy, move and delete report items are available under the ‘Edit’ menu 

or on the ‘Toolbar’.  Report scripts can be saved as .REP files using the ‘Save Script as’ function in 
the ‘File’ menu or on the ‘Toolbar’. 

 

The report creation is started using the ‘Make Report’ button. 
The report file (.DOC) is created in the Reports directory.  

E.3. Glaser diagram animations 

An animation of all successive Glaser diagrams can be generated from the ‘Report’ submenu or 
using the film-button on the ‘Toolbar’. 
 

 

Figure 22:  Animation generator 

The input parameters for the animation are (Figure 22): 
− the horizontal and vertical pixel size, 
− the animation speed in frames per second (the values of 15-20 are recommended), 
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− the output file name (*.AVI), 

− a video compressor, to be selected having started the creation.  The video compression 
options can be different on each computer. 

The animation file is created in the Reports directory. 
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CHAPTER F  CALCULATION PRINCIPLES 

F.1.  Introduction 

Three calculation methods are available in GLASTA. 
 
− The normal Glaser method. 

The Glaser method calculates for each period the temperature, the saturation vapour 

pressure and the vapour pressure in each interface (surface between 2 layers).  From this the 

vapour fluxes through the layers are derived.  If a discontinuity arrives in these fluxes, 
condensation or drying occurs in the interface between the layers under consideration.  In that 
case the interface water content changes by the amount of condensation or drying.  The 
material properties critical water content, maximum water content and initial water content do 
not effect the calculation. 
 

− The DIN Glaser method. 

This method is almost identical to the normal Glaser method.  In a first run (not reported) the 
normal Glaser method is applied to determine the most important condensation interface (if 
one occurs).  In the second run a constant quantity of water is assumed in that interface.  This 
amount is not affected by the amount of condensation or drying.  The ratio 
drying/condensation calculated in this way corresponds to a definition in the DIN 4108. 
 

− The extended Glaser method (Glaser++). 
The calculation of temperatures, saturation vapour pressures, vapour pressures, vapour fluxes, 
condensation and drying amounts passes identically to the previous methods.  The 

humidification or drying process is different, as the materials layers themselves (and not only 
the interfaces) are involved, depending on the status of the hup-flag (humidification possibility 
flag).  The critical water content and the initial water content of the different layers are used 

role in this calculation method.  Also the maximum allowed moisture front movement per 
calculation step effects this calculation.  A smaller value causes a higher subdivision of the 

climate periods during calculation. 

 
− the normal Glaser method and the DIN Glaser method are safe, i.e. larger condensation 

quantities are obtained, compared to the Glaser++ method, 
− the Glaser++ method corresponds better to the reality and provides a clear visualisation (easy 

to understand).  To simulate the drying of layers which are initially wet, it is the only method 
which can be used, 

− the normal Glaser method corresponds better to the reality than the DIN Glaser method. 

F.2. Preliminary assumptions in the calculations 

− The heat and mass flow is perpendicular to the wall.  It implies that water condensed stays in 
situ and cannot drain (although such a draining is realistic in some cases). 

− There is no airflow through the wall. 
− The hygrothermal properties of the wall layer materials are constant, i.e. independent of time, 

temperature and humidity. 

− For the saturation vapour pressure the following formula is used: 
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for  >= 0: ps=610.96 exp (0.07263  - 2.9507E-4 2 + 9.2011E-7 3) 

for  < 0: ps=610.96 exp (0.08236  - 3.0151E-4 2 + 1.3002E-6 3) [Eq. 1] 
 

− Latent heat of water is not taken into account. 
− Hygroscopic water content isn't taken into account. 

F.3. The normal Glaser method 

The following calculation steps are executed: 
 
− The temperatures in the interfaces (x) of the wall between two environments (1 & 2) are 

calculated using the following equations: 
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 [Eq. 2] 

 
 x =  2 - q R2x [°C] [Eq. 3] 

 
The course of the temperature between the interfaces is linear. 

 

− From these interface temperatures, the interface saturation pressures (ps) can be derived using 
Equation 1.  The course of the saturation vapour pressure between the interfaces is assumed to 
be linear. 

The effect of this last assumption, which is very small in most cases, can be diminished by a 
partition into sub-layers. 
 

− If there should be no limitation to the vapour pressure, the vapour pressures in the interfaces 
can be calculated using the following equations: 
 

 ]sm/kg.[ 2

21

12

 ++
= −

zdNz

pp
q

ii

m


 [Eq. 4] 

 
 px = p2 - qm Z2x   [Pa] [Eq. 5] 

 
− The course of the vapour pressure between the interfaces is linear.  If there is water in an 

interface y (because of previous condensation), the vapour pressure in that interface y is 

known.  In that case the unknown vapour pressures can be calculated also by equations 4 and 
5, substituting one of the environmental conditions by the vapour pressure in the interface y. 
 

− The vapour pressure is limited to the saturation vapour pressure.  It means that the interface 
vapour pressures, as they were calculated in the previous step, cannot be higher than the 
saturation vapour pressures already known.  Therefore, if necessary, the vapour pressures in 
the interfaces are re-calculated in such a way that the vapour pressure course is tangent to 

the saturation vapour course.  The vapour pressures in the interfaces between the points of 
contact are calculated by equations 4 and 5, substituting one of the environmental conditions 
by the vapour pressure in the point of contact. 
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− The vapour pressure course being known, the vapour flux in each layer i can be calculated: 

 

 ]/.[ 2smkg
dN

dp
q

ii

i
mi


=  [Eq. 6] 

 
If there is no contact between the vapour pressure and the saturation vapour pressure, this 
vapour flux is identical for all layers, and no condensation occurs.  In the case of contact 
points, the difference between the vapour flux at both interface sides is calculated.  This 
difference, multiplied by the duration of the period equals the amount of condensation (in case 
of a positive difference) or the amount of drying (in case of negative difference).  The sum of 

condensation quantities in all the interfaces provides the total amount of condensation or 

drying for the climate period considered. 
 

− The Glaser method is a stationary method.  It implies that the amount of condensation or 
drying is proportional to the duration of the period considered.  If there is water in an interface 
at the beginning of a calculation step, it means that the amount of drying could be higher than 
the amount of moisture present.  Therefore the duration of the climate period considered is 
divided automatically into two parts.  In this way the exact duration of humidity presence is 
calculated. 

F.4. The DIN Glaser method 

This method is almost identical to the normal Glaser method.  In a first run (not reported) the 
normal Glaser method is applied to determine the most important condensation interface (if one 

occurs).  In the second run, a small constant quantity of water (0.0001 kg/m2) is assumed in that 
interface.  The difference with the normal Glaser method is that this amount is not affected by the 
amount of condensation or drying.  In this way, (summer) drying is possible, even if physically 
spoken no water is present in the (winter) condensation interface.  The ratio drying/condensation 
calculated in this way corresponds to a definition in the DIN 4108.  From the calculation 
procedure explained it follows that this ratio can be higher than 1, while in the normal Glaser 
method this ratio is limited to 1. 

F.5. The extended Glaser method (Glaser++) 

The normal Glaser method allows predicting only the amount of condensation in the interfaces.  
In reality the condensation wets the materials themselves.  2 material types can be wetted by 
condensation: 

- capillary materials which absorb condensation. 
- non-capillary non-vapour-tight materials containing air pores (such as plastic foams) which 

can be humidified by condensation.  Such materials are characterized by a critical water 
content equal to the maximal water content (wcr = wmax).  

In the extended method no distinction is made between both groups.  They are identified in the 

wall data by the flag 'hup' (humidification possibility): hup = 1 or 0 depending on whether or not 
the material can be humidified by condensation, regardless the possible mechanism of 
humidification. 
 

The basis of the extended method is the definition of the critical water content of a material: the 
critical water content of a material is the water content above which the water transfer in the 
liquid phase starts; beneath the critical water content there is only water mass transfer by 

diffusion.  When a certain amount of water W [kg/m2] is added to a surface of a material layer, 
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the definition allows calculating the thickness over which the layer is critically humid: 
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In reality this uniform humidification is not instantaneous, but requires some duration to reach the 
equilibrium.  However, this duration is small compared to the slowness of the diffusion process, 
and therefore an instantaneous equilibrium is considered. 
 
The calculation process evolves as follows: 

 

− The vapour fluxes in the material layers and the amounts of condensation or drying in the 
interfaces are calculated as in the normal Glaser method, with the following supplementary 
rule: if a layer is partially humid, it is considered a substantive layer (with the same 
hygrothermal properties as the dry layer).  When a layer is humid, the vapour pressure in the 
adjacent interfaces is taken as the saturation vapour pressure, the course of the vapour 
pressure in the layer itself assumed linear.  The amount of condensation or drying in the 
interfaces being determined, the extended calculation starts. 
 

− If condensation occurs in an interface, the following three situations are possible: 
 1. For both adjacent materials hup = 0.  In this case the condensation cannot humidify them, 

and only effects the interface water content. 

 2. For both adjacent materials hup = 1.  The condensation is assumed to be absorbed by the 
layer at the cold side; (in the first instance, i.e. if the layers at that side become totally 
critically humid, the warm side absorbs the water).  This assumption is a simplification of 
the reality: both sides absorb a part of the condensation, the percentage being 
determined by the water absorption coefficients of the materials.  A simulation of this dual 
absorption would require additional material property data.  The assumption is 
acceptable because a humidification of the warm side, involving a shift of the waterfront 
to the warm side, causes normally a drying flux during the next subcycle, pushing back the 
waterfront.  

 3. Only for one of the adjacent materials hup = 1.  That material absorbs the condensation. 

 
− The absorption process in situations 2 & 3 uses the following rules: 

 - The layer is critically humidified starting from the condensation interface, over a thickness 
determined by the amount of condensation and the critical water content (equation 7). 

 - If total layer can be humidified, the condensation remainder is transferred to the next 
layer if for that layer hup = 1.  

 - If for that next layer hup = 0, the condensation remainder is transferred backwards, and a 
similar absorption process starts.  

 - If there is a condensation remainder after that one or several layers with hup = 1 and 

bounded by layers with hup = 0 or by the environment, are already critically humid, the 
water content in these layers increases above the critical water content.  If there is more 
than one such layer, the condensation remainder is distributed over these layers in 

proportion to the differences (wmax - wcr). In that way, all layers reach the maximal water 
content at the same time.  

 - The water content is not limited, but can rise above the maximal water content.  (If this 
occurs in reality, in fact a water layer is created.)  

 - During one calculation step, the user defined maximum allowable water front movement 
limits the displacement of a waterfront.  If the calculated amount of condensation should 
cause a larger movement, the duration of the calculation step under consideration 
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automatically is decreased.  The next calculation step is done for the remaining duration. 

 
− If there is drying in an interface, three situations may occur: 
 1. both adjacent layers are dry; in that case, the water present in the interface decreases by 

the drying amount,  

 2. both adjacent materials are wet; in that case, first the layer at the warm side of the 
interface is dried,  

 3. only one of the adjacent layers is wet; of course that layer dries. 
 

− The drying process in situations 2 & 3 is simulated in respect to the following rules: 
 - If the water content of the layer is larger than the critical water content, and if the drying 

amount isn't able to decrease the water content beneath the critical water content, the 
water content of the layer decreases uniformly by an amount determined by the drying 
amount and the layer thickness.  

 - If the water content of the layer is larger than the critical water content, but the drying 
amount is able to decrease the water content beneath the critical water content, the layer 
partially dries (starting from the drying interface) and partially remains wet.  

 - If the water content of the layer is smaller than the drying amount, the whole layer dries 
out.  The drying remainder is transferred to the next layer, and a similar drying process is 
started.  It the drying amount is larger than the amount of water available, the duration of 

the calculation step is automatically decreased.  The next calculation step is done for the 
remaining duration.  

 - If in several layers with hup = 1, bounded by layers with hup = 0 or by the environment, the 

total water content after the drying process is still higher than the total critical water 

content, the water content in them is calculated according to the same rule as in the 
condensation case. 

 - Again, during one calculation step, the user defined maximum allowable water front 

movement limits the displacement of a waterfront.  If the calculated amount of drying 
should cause a larger movement, the duration of the calculation step under consideration 
automatically is decreased.  The next calculation step is done for the remaining duration.  

 
As a result of the calculation process above, a new moisture distribution is found at the end of the 
climate period considered.  This new moisture distribution effects the vapour pressure course, 

because of the moving of the waterfronts.  Therefore, compared to the normal Glaser method, 

other condensation or drying quantities occur for identical climate conditions. 


